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Prologo 
La tesi secondo cui per il buon andamento aziendale basti avere i prodotti ed i servizi “giusti” risulta oggi 

difficilmente condivisibile, poiché i prodotti hanno cicli di vita brevi e anche i migliori diventano ben presto 

obsoleti. Non sono i prodotti, ma i processi che li creano ad assicurare l’andamento positivo nel lungo periodo, 

sia per il cliente finale sia per l’azienda. Per poter individuare le azioni di miglioramento occorre  

sistematicamente monitorare ed analizzare sia i processi che le loro interfacce interne ed esterne. Sviluppare ed 

analizzare i processi aziendali consente di creare la giusta astrazione per capire il business, procurare una base 

per creare opportuni requisiti ingegneristici, fornire un supporto per studiare le implicazioni dei cambiamenti, 

identificare opportunità di outsourcing, e cosi via. Data la complessità della progettazione e del controllo dei 

processi delle moderne supply chain, occorrono opportuni linguaggi e tecniche di analisi, che includano 

possibilità quali simulazione, diagnostica, verifica, valutazione delle prestazioni. Il linguaggio BPMN 

rappresenta una notazione standardizzata dall’OMG e comprensibile da vari attori: gli analisti che definiscono i 

processi, gli sviluppatori che ne guidano l’implementazione tecnologica, i responsabili della gestione e controllo 

dei processi. BPMN è traducibile da e in formati XML per l’esecuzione dei processi, quali lo standard WS-

BPEL 2.0 per ambienti service-oriented. Il presente seminario prevede l’illustrazione della notazione BPMN 2.0 

attraverso un insieme di esempi, ed esercitazioni pratiche su casi di studio relativi all’analisi dei processi. 

Sommario 
Introduzione a BPMN 2.0; caratteristiche generali; flusso di controllo e concetto di token; diagrammi di 

processo; esempi. Costrutti BPMN di base: processi, sottoprocessi, task; flussi di sequenza e punti decisionali; 

eventi iniziali, intermedi, finali; partizioni, pool, corsie; flussi di messaggi; artefatti: oggetto dati, gruppo, nota 

testuale. Consultazione della specifica BPMN 2.0 e costrutti avanzati: tipologie di evento, di processo, di punto 

decisionale, di flusso. Estendibilità del BPMN 2.0. Strumenti per la modellazione di processo in BPMN 2.0. 

Laboratorio didattico su BPMN e Business Process Analysis. 

 

Il relativo materiale didattico è pubblicato su http://www.iet.unipi.it/m.cimino/gpa (user: business, pass:pr0cess) 
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Caso di studio con processi eseguibili: 
BP Analysis con BPMN 2.0 e SOA Traceability 

• Internet of Things: paradigma promosso da un imponente consorzio (Auto-ID Labs, 

EPCglobal) come modello di Supply Chain del futuro: l’applicazione massiva di 

etichette elettroniche (RFID) consentirà a tutti i beni (libri, scarpe, vetture e relative 

parti, ecc.) di essere acceduti da qualsiasi parte del mondo, come avviene oggi con i 

documenti web. Una rete Internet di oggetti fisici. 

• Esempi di dispositivi basati su Tecnologia RFID: 
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• Infrastruttura di gestione della Tracciabilità con Internet of Things: 
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• Esempio di infrastruttura su filiera “corta” composta da (A) Capofila e (B) terzista. 
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• Esempio di dati tracciati dall’esecuzione di processi produttivi: 
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• Scenario di Tracciabilità/Rintracciabilità di Processo.  

 

• Tracking = lasciare tracce; Tracing = rintracciare. 
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• Agent Oriented Architecture (AOA) per la tracciabilità di processo 
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• Un sistema di traccabilità consente di registrare dati sulla esecuzione dei processi (es. 

istante iniziale e finale di lavorazione, non conformità di una lavorazione). 

• Tali dati consentono di calcolare degli indicatori di performance (Key Performance 

Indicator, o KPI). Esempi: percentuale media di non conformità del prodotto; tempo 

medio e varianza di un processo produttivo; tempo medio e varianza di una attività o 

processo. Percentuale media di studenti che superano un test finale in un processo di 

e-learning. 

• I KPI sono identificati a seguito di obiettivi strategici su cui focalizzare il 

raggiungimento dei risultati, rappresentati dai fattori critici di successo (Critical 

Success Factors o CSF). Esempi di CSF: Riduzione del tempo evasione ordini; 

Riduzione dei difetti rilevati in produzione; Saturazione della capacità produttiva; 

“zero” studenti oltre il terzo anno fuori corso. 

• Cosa ci facciamo con un sistema di tracciabilità di processo e un sistema di calcolo 

di KPI? Molte cose. Ad esempio, la Process Awareness nella Supply Chain/Supply 

Network: la consapevolezza del ruolo di un’azienda nel sistema filiera emerge 

tracciando ed analizzando le interrelazioni scaturite dalle esecuzioni. 

• In una metodologia completa di Process Awareness occorre estendere il BPMN 2.0 

con nuovi costrutti “eseguibili” per poter tracciare e rintracciare i processi. La 

piattaforma eseguibile dei processi di analisi è un sistema di tracciabilità “goal-

oriented”. 
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• Esempio di estensione della notazione grafica per la visione di analisi1 (tracing) e 

tecnologica2 (tracking) dei processi.  

• A sinistra viene rappresentato un Business Rule Task all’interno di un processo, ossia 

un meccanismo per fornire in input ad un Business Rule engine dei dati ed avere poi 

dei risultati dal medesimo. In tal modo l’analista può indicare nel diagramma BPMN 

i task che hanno associati dei KPI da calcolare, es. tempi medi di elaborazione. “QE” 

sta per Quality and Efficiency (vedere modello KPI successivo). 

• A destra vengono rappresentati degli eventi intermedi di Tracking, nella fattispecie 

sono multipli. L’analista può così offrire una vista tecnologica, indicando i punti in 

cui occorre tracciare dati (es. istanti di ingresso ed uscita). 

 

• Ogni costrutto ha poi delle informazioni strutturate che vengono associate, modellate 

in UML ed XML. 

• Nel seguito viene mostrato un modello UML per tali informazioni. 

 

1 2 
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• Modello dei KPI nella BPMN 2 extension. 
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• Modello che rappresenta i dati tracciabili nella BPMN 2 extension. 

 

• Esercizio: progettare (in BPMN 2 su Visio) un semplice modello di Business Process 

Analysis che si basi sull’architettura eseguibile illustrata. 
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Strumenti per la modellazione di processo in BPMN 2.0 

• Al momento ci sono 75 strumenti di modellazione per il BPMN: 

http://www.omg.org/bpmn/BPMN_Supporters.htm 

 

• Nel seguito verrà modellata la gestione dei libri di una biblioteca con due strumenti, 

rispettivamente, per processi non eseguibili e processi eseguibili.  

[1]ActiveVos 

[2]AccuProcess:Business Process Modeller 

[3]Activity 

[4]Altova: UModel v2008r2 

[5]Avolution: Abacus 

[6]Appian Enterprise 5 Business Process Management Suite 

[7]aXway: Process Manager™ 

[8]Business Process Incubator 

[9]Barium Live! 

[10]BizAgi: BPM Suite 

[11]BOC Group: ADONIS® 

[12]Borland® Together Designer® 2006 

[13]BPM-Xchange® Product Suite 

[14]Casewise: Corporate Modeler™ 

[15]Cordys: Business Operations Platform 

[16]DAI-Laboratory: VSDT 

[17]Ekuar 

[18]eliXir BPMN-MDA Framework 

[19]ELMA 

[20]EMC Documentation Process Suite 

[21]Embarcadero Technologies: ER/Studio Business Architect 

[22]bxModeller 

[23]Fujitsu: Interstage Business Process Manager 7.1 

[24]Ciboodle: Sword 

[25]Global 360:Analist view 3.0 

[26]HandySoft Global Corp: BizFlow® BPM 

[27]IDS-Scheer: Aris™ 

[28]Corel: iGrafx™ 

[29]ILOG: JViews™ 

[30]IMSX Pty Ltd (partner of Bizagi) 

[31]Image Technology 

[32]Intalio|BPMS 

[33]Intellior AG: AENEIS 

[34]Interfacing Technologies: Enterprise Process Center; Free BPMN Modeler 

[35]ITpearls: Process Modeler for Visio 

[36]inubit AG: inubit BPM-Suite 

[37]intellivate : IYOPRO 

[38]ISIS Papyrus 

 

[39]JBoss, RedHat - jBPM 5.0 

[40]Joinwork Process Studio - A BPMN 2.0 Modele r 

[41]Kaisha-Tec: ActiveModeler Avantage 

[42]KnowGravity :KnowEnterprise 

[43]Lanner: Witness™ 

[44]Lombardi Software: TeamWorks® 

[45]M1 Global: BPI Studio 

[46]Mega International: Mega Suite™ 

[47]Metastorm: Metastorm Enterprise™ 

[48]MID: innovator 

[49]No Magic: MagicDraw 

[50]Oracle Business Process Management Suite 11g 

[51]Orbus Software: iServer 

[52]Oryx: Web-based Collaborative Process Modeling 

[53]Pallas Athena: BPM|one® 

[54]Process Master: ProcessPad 

[55]Pegasystems: BPMSuite 

[56]QPR Software: QPR BPM Suite 

[57]Seagull Software: LegaSuite BPM 

[58]Signavio GmbH: Signavio Process Editor 

[59]Software AG: Enterprise Business Process Manager (EBPM) 

[60]Popkin: System Architect™ 

[61]Santeon: XIP BPM Platform 

[62]SAP: SAP NetWeaver Composition Environment (CE), component SAP 

NetWeaver Business Process Management (BPM) 

[63]Savvion: Process Asset Management 

[64]Select Business Solutions: Select Business Modeler & Select Architect 

[65]Skelta: Skelta BPM.NET 2006 

[66]Soyatec: eBPMN Designer 

[67]Sparx Systems: Enterprise Architect 

[68]SAPERION AG: SAPERION ECM & Workflow 

[69]Sun Microsystems: Studio Enterprise Edition 

[70]Sybase: PowerDesigner® 15 

[71]Tibco: Business Studio ™ 

[72]Troux™: Metis 3.6 Enterprise Architecture Suite™ 

[73]Whitestein Technologies: Living Systems® Process Suite 

[74]Visual Paradigm: Visual Architect™ 

[75]WebRatio: BPM Free Edition and BPM Pro Edition 
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BPMN 2.0 Modeler for Visio Version 2.1 

• Strumento di drawing puro, consente di disegnare i processi in modo libero, 

costruendo estensioni, e senza vincoli di eseguibilità. 

• Download (freeware): 

http://www.businessprocessincubator.com/bpmn-2-0-modeler-for-visio.html; 

• Requisiti: 

Visio 2003 o superiore (Disponibile con licenza accademica di Facoltà) 

• Installazione: semplicissima, ⇒ lingua italiana; 

• Uso: semplicissimo. A sinistra appaiono due pannelli (stencil) contenenti i costrutti 

per la modellazione di processi (orchestrazioni) e collaborazioni (coreografie) 

BPMN. Il diagramma si costruisce tramite il drag&drop dei costrutti grafici. 

• Caratteristiche di massima: ottimo per analisti del business, ottima integrabilità 

con strumenti di documentazione e presentazione aziendale. Offre il set completo di 

elementi e di diagrammi BPMN 2.0, come descritto nella specifica ufficiale. 
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• Semplice coreografia per l’interazione tra lettore e biblioteca. 
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• Semplice orchestrazione per la gestione dei prestiti libri (processo GestioneLibro). 
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Intalio|Designer 6.x 

• Suite modulare per l’intero ciclo di Business Process Management.  

• Il modulo Designer consente di costruire i diagrammi eseguibili ed esportarli in 

formato processabile sul modulo Server, per ambienti SOA.  

• Viene supportato da una community molto attiva: 

http://community.intalio.com/tutorials-5.2/implementing-your-first-process-in-5.2-

beginner.html 

• Download: http://www.intalio.com/downloads; 

• Reference guide http://community.intalio.com/reference-guides.html 

⇒ Intalio|BPMS Designer - BPMN Flow Objects 

• Installazione: semplicissima, ⇒ lingua inglese; 

• Legenda: 

⇓ digita ∅ premi  ⇒ seleziona con tasto sx   ⇐ seleziona con tasto dx 
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• Primo diagramma:  

1. ⇒ File ⇒ New ⇒ Intalio|Designer Business Process Project; 

2. ⇓ Project name (es. mioprogetto); 

3. ∅ Finish; 

4. DX⇒ in scheda Process Explorer (Fig.1) ⇒ New ⇒ Business Process Diagram; 

5. ∅ Finish; 
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• Semplice coreografia per l’interazione tra lettore e biblioteca.. 
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• Semplice orchestrazione per la gestione dei prestiti libri (processo GestioneLibro) 

 

• Notare: (a) Lettore è un pool non eseguibile; (b) Bibioteca è eseguibile; (c) La 

variabile book associata al gateway, consente l’eseguibilità del processo. 

Nota: se mancano alcune schede, andare sul menu Window ⇒ Show view. 
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• File WSDL generato: descrizione dei web service in termini di scambi di messaggi. 
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• File BPEL generato: notare il ramo if-else del processo eseguibile. 
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• Per verificare la eseguibilità salvare il diagramma, appariranno dei warning (“x”).  

• Vincoli di eseguibilità sui pool. Esempio: un pool eseguibile deve partire con un 

messaggio. Generalmente è un pool non eseguibile che lo invia. 

• Soluzione: ⇐ sul pool ⇒ set pool not executable. 
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• Vincoli di eseguibilità sui gateway. Esempio: un gateway deve avere un ramo di 

default. 

• Soluzione: ⇐ su un ramo ⇒ condition type ⇒ default 
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• Vincoli di eseguibilità sui gateway. Esempio: un gateway deve avere una variabile 

decisionale associata. 

 

• Soluzione:  

1. Aggiungere il costrutto variable dal pannello “Basic BPMN Shapes” 

2. Collegarlo al Gateway  

3. Selezionare il Gateway 

4. Nella scheda Mapper collegare la parte destra “condition” con la variabile a sinistra. 

5. Salvare il progetto 
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• Collegamento di una variabile al Gateway tramite il Data Mapper. 
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• Intalio|Designer supporta i vari elementi della versione 2.0. Tuttavia, per poter 

rappresentare alcune tipologie, può essere necessario collegare ai costrutti grafici 

degli elementi eseguibili. Ad esempio per specificare i tipi di task. 

• Questo lo rende uno strumento poco accessibile in fase di analisi e di modellazione 

ad alto livello di astrazione. 
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Business Process Visual Architect 5 

 

• Suite per simulare l’esecuzione di processi. 

• Download: http://www.visual-paradigm.com/download/bpva.jsp; 

• Decomprimere, eseguire bin/ Business Process Visual ARCHITECT 5.0.exe; 

• Workspace: selezionare una cartella come spazio di lavoro; 

• Request Key: registrarsi o loggarsi, per ricevere via email un Product Key mensile; 

• Import Key: caricare il file zvpl ricevuto. 

• Legenda: 

⇓ digita ∅ premi  ⇒ seleziona con tasto sx   ⇐ seleziona con tasto dx 
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• Primo diagramma:  

1. ⇒ File ⇒ New Project; 

2. ⇓ Project name (es. mioprogetto); 

3. ∅ Create blank project; 

4. Si apre automaticamente un  Business Process Diagram; 

5. Creare il diagramma con la tavolozza di sinistra. 
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6. ⇒ Modeling ⇒ Simulacian; 

7. Selezionare un task, inserire durata e costo necessari per completarlo una volta. 
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8. Dati relativi a ogni attività del modello. 
 

Attività Durata media (min) Costo medio (EUR) 

Taglio 25 16 

Preparazione Componenti (interna) 28 31 

Preparazione Componenti (esterna) 24 48 

Assemblaggio (interno) 93 67 

Assemblaggio (esterno) 68 93 

Controllo qualità e confezionamento 42 26 

Esternalizzazione * 5 2 
 

9. Definire il numero di risorse (pool) a disposizione1, la velocità di simulazione2 e la 

valuta3; 
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10. Creare uno scenario, cliccando su una parte bianca del modello e poi ∅  Add; 

11. Inserire la frequenza di esecuzione dello scenario, il numero di casi (token); 

12. Costruire il percorso riguardante lo scenario, tramite l’area Path. 
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13. Scenari ipotizzati: produzione interna ed esterna. 
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14. Cliccare su Play/Stop/Pause per eseguire gli scenari. 

15. Triangoli rossi → token in attesa; pallino verde → token in elaborazione; 

16. A fine simulazione appare il tempo ed il costo totale; 
 

 
 

17. All’aumentare delle risorse (pool) aumenta il grado di parallelismo; 
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18. All’aumentare dei casi aumentano i token (somma tempi e costi); 

19. In caso di più scenari, i casi sono ripartiti in percentuale (es. 30% int.,70% est.); 

20. Cliccando sull’icona a destra  si ottengono dei grafici con l’andamento dei 

parametri principali di simulazione; 

21. Livello di completamento nel tempo: input da fornire, da elaborare ed elaborati: 
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22. Uso delle risorse nel tempo: 
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23. Tempo di accodamento 
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24. Costo per flusso (costo d’uso) 
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25. Costo complessivo dello scenario 

 

26. Andamento temporale del costo 
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27. Esercizio 

Si supponga di dover produrre 40 borse, tramite una combinazione dei due scenari di 

produzione interna ed esterna, con una sola bottega e un solo terzista. Simulare: 

a) uno scenario di produzione totalmente interna, interpretare risultati/grafici; 

b) uno scenario di produzione totalmente esterna, interpretare risultati/grafici; 

c) individuare una combinazione degli scenari in grado di essere realizzata sia in 

minor tempo sia in minori costi rispetto ai casi a) e b); 

 

Soluzione 

a) 100% → 5g 5h 20' 5600€, maggiore accodamento ultime fasi, provocato dalla 

serialità del flusso; 

b) 0% → 3g 6h 52' 7640€, maggiore accodamento su assemblaggio, essendo una 

attività di maggiore durata;  

c) svolgendo internamente una parte minore si bilancia l’assemblaggio e si riduce 

l’accodamento, risparmiando nel tempo complessivo e in termini di costi:  

Es. 20% → 3g 2h 38' 7232€ 


